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Introduction

The AVANT REMSsp represents a new era of precision in-situ verification for your office. Compact yet
rugged, this PC-Based system is USB powered and supports ANSI and IEC Real Ear tests. The software
includes targets for DSL i/o 5.0 and NAL-NL2. The REMsp is an affordable, single probe device which
utilizes MedRx’s in-situ method for getting the fitting right the first time, every time.

The Avant REMsp device performs Live Speech Mapping and Real Ear Measurements where
measurements are performed directly on the client's ear. These measurements can be done with or
without a hearing instrument being in place.

The reason to perform Real Ear Measurement for hearing instrument fittings is because shape and size
of an ear canal significantly influence a hearing instrument's performance. Knowing the sound intensity
outside and inside the ear enables the practitioner to determine the actual amplification and output that
the test person receives through the hearing aid and make the appropriate adjustments.

The following section of this manual will familiarize you with the physical features and accessories of the
REMsp system.

This manual assumes that the system hardware, software and drivers are installed and working properly.
Please refer to the MedRx AVANT REMsp Installation Manual for assistance.

The scope of this manual is to get you “up and running” with the Avant REMsp System. Please consult
the interactive Help System within the software for more detailed information of features and functionality.
To access this tool, press the F1 key at any time, or click the Help icon or menu item with your mouse.

Measurement uncertainty is +/- 1 dB.

Also refer to the Help files for test signal characteristics, analysis, equalization methods and the effect of
analyzer setting on accuracy.

This device and transducers are intended for use at test frequencies between 125 Hz and 8000 Hz.
This unit meets the requirements of both ANSI S3.46-1997 and IEC 61669:2001. Those standards
specify the required precision that the Avant REMsp does achieve.

ASP-I-MASPT-9 MedRx AVANT REMsp Training Manual
Effective Date: 10-21-2016



The AVANT REM Software

General Overview

The AVANT REM software will either run as a measurement module within NOAH" or as a stand-alone
module, or in the TIMS NOAH-Compatible Office System.

The software includes a context-sensitive interactive Help System. To access this tool, press the F1 key
at any time, or click the Help menu with your mouse. This will display additional information and
instructions for the specific section of the software you are working in.

W ™

N g T i+

AVANT"

ReAL EAR MEASUREMENTS

The AVANT REM Main Screen

Launching the REM Software

Stand Alone NOAH and TIMS

P

iy

N AVANT REM

EvanthEv)
e Double click the e Launch NOAH.

AVANT REM shortcut e Launch AVANT REM module
on your Windows following NOAH procedures.
Desktop.
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Software Options

Basic Options

Several options are available which allow the user to customize the AVANT REM Software to meet their

needs.

Access these options from the File Menu on
the Avant REM Main Screen as shown below.
b S et s |

GIEE Function  Help

Clear Session Data

Print Setup...

Page Setup...
Advanced Opgs. v
Exit

The Options may also be accessed
from within the Avant REM main
program by clicking on the Options

text menu as shown below.

File Function Ear

HL

Audio  Stimulus %
) | ©)

The software allows you to set several default options as described below.

View | Audio | Live Speech | REM | MHAHLS | Tymp |

Speech Spectum
I¥ Cance

J¥ Speech Sounds
Language:

Plat
I Vetical Grid
¥ Horzortal Grid

Sight ——————————
Styie: [Lnes -
Size: [30

¥ Hide Plots During Test

Dual Plot: |Where Possible ¥

Fortt Size:

<Default> 2 =

Default Ear: |Right | *
Plot Curves Width: [Medium +

I# Use Plot Antialiasing

|

i~ )]
Audio h Speech -7
Mapping
5
View | Audo  Live Speech | REM | MHAHLS | Tymp | View | Audo | Live Speoch REM | MHAHLS | Tymp |
~ Live Speech Defautt Stmulus: [Microphone - Defaut Stimuius ArcogoBeings:[5 %
¥ Show Fall Sounds - i ¢
Defaul Level: [55 =
= B
I Show Peak Saunds Dot Lovel: [ SmRiE
Smooth O/E: [T - =
e e — R — A ————— Sample Aversging Tims (s2c): [0 =]
Octave Bands: [1/3 | Dernkt Fimiction lm Octave Bands: [1/3 | =
¥ Intemolate Curves ¥ Intemolate Curves ICRA Averaging Time fsec). [15 =]
i Threshod (@8) [ = i =

Show Targets Rollng Window Gec): [ =1
<None> -
™ Show MCL Save with LSM: [¥

Show Targets

[¥ Show KEMAR=t [70 ~| dB

Speskers: Speskers:
e Live Painting Mods I Show Average LCL pe s I Show SPL Reference Curve pEEeR
e <Not Availzble> =
e s Ful Canvas | I Show REUR on REAR
0K | Cancel | Help | 0k | Cancel | Help 0k | Cancel | Help |

The View tab allows you
to set the default
appearance of the
REMsp test environment.
Values can be changed
by using the check boxes
and pull-down menus
shown above.

The Live Speech tab sets
the look and behavior of the
Live Speech Mapping
function. Use the Show
Targets pull-down to
underlay DSL 5.0 or NAL-
NL1 & NL2 targets below
your speech maps.
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The REM tab sets the
default look and behavior
of conventional Real Ear
Measurements.




)

"View | Audo | Live Speech | REM  MHA/HLS | Tymp |

rHLS

Default HLS Leve!

= =
Normal B

M inSPL " inHL

HLS Simulation:

Use Live Speech Mapping:

Default MHA Level: |50 =

Normal 2

Use Live Speech Mapping ¥

MHA Simulation:

o]

|

The MHA/ HLS tab sets the default look
and behavior of the Master Hearing Aid

and Hearing Loss Simulator.

NOTE: Remember, that more information is always available in the Interactive Help System by clicking

the Help Icon or pressing the F1 key.

Advanced Options

The Advanced Options screen allows you to configure your
system to meet your individual clinical needs. It also provides
MedRx Technical Support with tools for helping you
troubleshoot problems. Access this screen from the File Menu
on the Avant REM main Screen as shown to the right.

The key features of each tab are described below. For more in-depth information, consult the interactive

Help system within the software.

Advanced Options

General | Audio | Video | Tympanomety |

CD-ROM Drive: |D 2

™ Multiple Monitors

¥ Do Net Disconnect from NOAH when Fitting

Home Directory

Install Drivers
Device Manager
Control Panel
System Information

Cancel |

o]

Help

The General Tab configures the overall Avant

REMsp behavior with respect to other

Windows programs, specifically NOAH.
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ostions ]

View | Audio | Live Speech | REM | MHAHLS Tomp |

¥ Show The Nom Area Scaling: ~
I¥ Auto Switch Modes
¥ Intemolate Curve

I~ Alow Mutiple Records

Concdl | Heb |

.

If your system has a Tympanometer
connected, this tab will assist in
configuring the look of the display.

Function Help

Clear Session Data

Print Setup...
Page Setup...

Options...

| Advanced Options...

Exit

Advanced Options

General Audio | Video | Tympanometry |

Output Device: |3

Input Device: [Microphone (MedRx REM-SP Audio) |
Output Mixer: |MedFoc REM-SP Audio |
Input Mocer: [ MedFix REM-SP Audio =
Input Line: [<Default Line> =

Ok | Concel | Hebp

Use the Audio Tab to select the proper audio device
for your Avant REMsp. This tab also provides access

to the Windows Audio controls.




: -
e = If your system has a Video Otoscope, the Video Tab
E i R allows you to select the appropriate input device.

rCtoscope Input

Device: IR ~ |

Source | Format | Aadjust |
[ Altemative Input
Device d
Source Formnat Adjust

QK I Cancel Help

Advanced Options x|

Genersl | Audo | Video  Tympanometry |

Tympanometer:  [INRENETIRIA

If your system has a Tympanometer connected, use
this tab to configure the equipment according to the
manufacturer’s instructions.

0K I Cancel Help
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Preparing For Testing
Connecting the Speaker Dj

Reset the volume to maximum every
time the speaker is turned on.
Press the + button until beeping is heard.

The green battery light will
illuminate when charging.

Slide white switch to the
middle position to turn
speaker on.

Speaker front side is
shown.

Optional Plugs /

Plug
power
cord in
as
shown.
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The front side of the speaker is
placed at a distance of about 1
meter (19”-39”) from the patient,
for normal use.

It is preferred to plug the speaker
into the power supply but it may
be powered by the internal
battery.

The Bluetooth option is not used.

The speaker’s power cable is a
USB “male A to micro-B type”,
connected to the power adapter.

Powering the speaker via a
computer USB port is not
recommended.

Plug cable into
speaker jack and
connect to your
REMsp as
indicated.




[Q Speaker Calibration

Open the Speaker Calibration screen from REM/LSM screen menu Tools > Calibrate
Speakers.

The speaker should be positioned in such a way that nothing blocks the path of the emanated sound in
front and on the sides of the speaker. For example positioning a speaker behind a monitor is incorrect
and can severely affect its response at the measurement location. The speaker diaphragm should be at
about the same level as the patient's ear and the reference microphone.

Place the reference microphone at the location where the patient normally sits, or about 1 meter from the
speakers.

Click on Start to begin the calibration and wait until it ends. Observe the response curve to flatten itself
out. The darker curve is showing the response used by the equalization algorithm, the lighter curve is
showing the current microphone input. Use of the powered speaker supplied with this device is
recommended.

Positioning the Speakers

Proper positioning of the
loudspeakers relative to
the patient’s hearing
aids is critical for making
accurate and repeatable
measurements. Seat the
patient so their ear is
between 19 and 39
inches from the
loudspeaker.

19 ” _ 39 ”
(48 - 100 cm)

Make sure the grill of the loudspeaker is level with and directly in front of the patient’s head.

When using Live Speech inputs, position the patient so the mouth of the person speaking is in the same
position as the loudspeaker shown here.
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Calibrating the Probe Tube v O

The calibration date is available under the Function > Calibrate > Calibration Information tabs. Return the
Avant REMsp to MedRx for annual re-calibration. Annual re-calibration of the Avant REMsp device is

recommended. v There are no user repairable components of this device.

For reasons of infection control and reliability of results, MedRx recommends that a new probe tube be used with
each patient. To ensure accurate measurements, it is necessary to calibrate the probe tube each time it

is replaced.

1. Place a new probe tube on the probe
microphone port as shown.

2. Place the probe tube between the
calibration nibs as shown. Be sure
that the opening of the probe tube is
centered on the opening of the
reference microphone.

In the Avant REM software, do one of the following:

e Click the Probe Tube %
Calibration Icon. 'mm

Position probe microphone between 19 and 39
inches from the loudspeaker and click Start.
The signal must be at least 70 dB to complete
a valid calibration. If the screen prompt
indicates the signal is too low, increase the
volume on the loudspeaker or move the probe
microphone assembly closer and

restart the calibration.

Valid calibrations have the same approximate
shape as shown here. If the measured
calibration curve differs greatly in shape or
amplitude from the target curve, replace the
probe tube and re-calibrate. If this does not
correct the problem, contact MedRx technical
support at (888) 392-1234.
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Delete
. Delete Al
e Click Tools.
® CIICk Reset Diata
Calibrate Yiden Preview Shift-Enter
Probe Tube.
Probe Monitor
Calibrate Probe Tube
prabe caiprocon x
Microphone: IPlobe ;I
ReferenceLevelk | 0 4B
- Place probe tube on top of the reference microphone.
- Start calibration.
- Adjust the volume so that the Ref. Level is above 70dB
e
Start | Stop | |
View I Help Close
10




Live Speech Mapping

Step-by-Step Guide to Live Speech Mapping

Ensure the Audiogram is Entered

Before making Live Speech Mapping measurements, the patient’s pure tone audiogram must be available
to the software. This can occur several ways:
1. The audiogram was automatically entered by MedRx AVANT, AVANT Audiometer or AVANT
A2D software when testing. Then saving the NOAH session.
2. The audiogram was manually entered into the NOAHaud 3 or Noah 4 software and saved.
3. The audiogram was entered using another manufacturer’s audiogram module.

You may also manually enter the audiometric data into the AVANT REM software as follows:

17 0t E

sk ) N
1. Launch the audiometric module by 2. Using your mouse, select the test ear.
clicking on the Audio button on the right 3. Select the test type Air.
side of the AVANT REM main window. 4. Enter thresholds by clicking the intersection

points with the mouse. (You may also enter
the audiogram by selecting the audio tab in
either the LSM or HLS/MHA screens).
5. Repeat for UCL (Bone and MCL optional).
6. Repeat steps 3-5 for the other ear.

After the audiogram is entered, click the Back button to return to the Avant REM main screen.

D)
sm [y

Q)} 2. In the next Window. Click LSM again.

1. From the AVANT REM Main screen, click LSM.

Line
Speach

[lapping %
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Speech Mapping with Live Voice Inputs

The screenshot on the left shows the
Live Speech Mapping (LSM) window.
The system was designed to capture
. and display the human voice in the

3 //\ b | P ® & earcanal, so we recommend using

] # ¢ = the microphone input and the peaks

i ¥ = . »# Mmeasurement.

- | - Using the microphone allows

a2 © oot o

o} “ ‘ ”m” 5 @ @ professional’s voice and that of the
M — m”'k""“”'!”!!ﬂ""‘!'.” . “’”l‘“‘“@ et ey patient’s significant others.

Frequeny [ He) Freaumecy [Hz]

To improve repeatability of
==t~ x s measurements, it is recommended

= that the speaker read a standard
passage such as the “Rainbow
Passage” which is provided on pg. 26.

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also possible
to underlay DSL i/0 or NAL-NL2 targets on this screen. Click Options + Show Targets in the text menu
bar on the top of the screen to select and configure these underlays to meet the needs of your practice.

Speech Mapping with Recorded Inputs

aleix

= For those who prefer a recorded,
(B repeatable stimulus for Speech

$ &  Mapping, the software provides
il e several digital audio files. These are
e o I ~ & accessed by clicking the File button
= o 2 ¢ = onthe right and then selecting the
- ' _w» desired track from the pull-down
- L2l & It ®  menu in the audio player. Peak
ol B * °  measurements is recommended.

| e & @ Once the desired track is selected,
v ] Rt R o ] click the Start button to begin
s i measuring. A pure tone or white
1 noise will be presented and once it
T e e % ., reaches the selected input level with
== Z__ the slide bar, the chosen track will
play. When enough data is collected,
click the Stop button to stop the
recording and capture calibration
measurement.

It is also possible to use an audio CD, such as the patient’s favorite music to perform Speech Mapping.
Simply click the CD button and then select a track as above. Use the sound level meter on screen to
check the proper level. Adjust the output of the speaker to desired level using the sound level meter.
(Remember conversational speech is 65 dB at 1 meter).

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also possible
to underlay DSL i/0 or NAL-NL?2 targets on this screen. Click Options + Show Targets in the text menu
bar on the top of the screen to select and configure these underlays to meet the needs of your practice.
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The screen shot below provides an overview of all the tools

and controls on the Live Speech Mapping

screen. For more information on these features, please consult the Interactive Help system by pressing

the F1 key or clicking the Help icon.

Sound level meter
Ear selection
Measurement type
a. Peaks
b. LTAS
Input Selector

1.
2.
3

Som~NoO

Open Fit Function

Reset Button

Test Interrupter

Discard, Help and Back buttons

Legend

Target area — can be any of the following:

e MedRx Modified Speech Spectrum
e DSLilo
e NAL-NL2

File Function Ear Audic Stimuls Options... Teols Help

HL Qj| e @ ‘ | = - —— [70
Audio 7| | speeen 0 I p— o
‘ | fir) Mapwing E B 45 65 s
@ B6dB 9 75
Left Ear Right Ear
SPL (dB) SPL (dB)
120 120 it
/ —_— /»—__‘_ Peaks LTas
110 110
|
/
100+ 100~ -
a0 i
%0 %
a0 80
70 / 70 &‘/
£0 &0
4
50 50
= b \(/’(
”\H‘ MWWWWW |
o os 250 500 750 1k 15 2k 3k 4k Bk Ek‘ £ [k 250 500 750 1 15 2 E gk o | -
Frequency [Hz ] Frequency (Hz )
5
[11. Speech In uiet - Male: =l
Time: [00:05 » n [ ] 0 x :
=0 [T T | D Help By
1 512002008
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Running Speech Mapping “On-Top” within NOAH

It is well established that verifying the output of hearing instruments in the patient’s ear will improve the
accuracy of the fitting. The AVANT REMsp system is tightly integrated with NOAH, the industry standard
for audiometric and fitting data storage and retrieval. The “on-top” mode of the REM software allows you
to effortlessly alternate between measurement and fitting adjustments.

File Function Help

LS%

From the Avant REM main screen, click the NOAH LSM button.

The REM window will reduce in size and “float” on top of the NOAH screen.

Open the fitting module from the NOAH Module Selection Screen.

Use the text menus and green and red buttons in the floating LSM window
to make Speech Mapping measurements.

Make necessary changes to the instrument based on these
measurements.

To make adjustments to the hearing instrument, click on the fitting module
window and modify the settings according to the manufacturer’s
instructions, being sure to activate, apply or save the settings to the
instrument.

Repeat this measure/adjust/measure cycle until the fitting is optimized.

Completing the On-Top Mode Process

Close the REM module by clicking the X button or go up to the File menu and down to Exit. Save the
NOAH session when prompted.

ASP-I-MASPT-9 MedRx AVANT REMsp Training Manual
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MedRx Live Speech Mapping Protocol

Unlike other products, the AVANT REMsp system places full control over the measurement environment
firmly in the hands of the hearing care professional. The system is powerful, yet extremely flexible,
allowing each provider to use Live Speech Mapping in a way that compliments their practice style rather
than compromising it.

In order to get you “up and running” with the AVANT REMsp system, MedRx has developed the following
protocol. This simple procedure has been found to be effective with both audiologists and hearing
instrument specialists. After mastering the basic operation of the system utilized in this protocol, you are
encouraged to further expand your use of Live Speech Mapping in your practice. Feature-specific help is
available by simply pressing the F1 key or clicking on the Help icon or text menu.

1. Complete a careful otoscopic examination as instructed by
the manufacturer of your otoscope.
a. For MedRx Video Otoscopes, refer to the Help
system within the software by pressing the F1 key
or clicking the Help icon or text menu.

2. Basic Diagnostics.
a. Using your audiometer and NOAH, measure and
record the following values:
b. Pure Tone Air and Bone conduction thresholds.
c. Narrow Band Noise or Pure Tone UCL at 500,
1000, 2000 and 4000 Hz.
d. Other tests if needed in your practice or jurisdiction.

3. Position patient as described earlier in this manual.

4. Calibrate Probe Tube as described earlier in this manual.
5. Measure and place the probe tube in the ear canal. (Use
chart to the right).
6. Complete a Live Speech Mapping measurement UNAIDED.
a. Microphone or file input
b. Peak Measures
c. 1/3 Octave resolution

e
7. Carefully place the hearing instrument in the ear without

disturbing the probe tube. Probe Tube Insertion Guide
for Live Speech Mapping
and Conventional REM

8. Complete a Live Speech Mapping measurement AIDED. (re: Pomford, 1 & Sinclan, 5. Real-Ear Measurement:
Basic Terminology and Procedures. Audiology OnLine.com)
9. Using the On Top Mode, make any adjustments needed to N | m—
the hearing instrument so that: Male (30mm)
a. The LSM curve for Quiet Speech (50 dB) is at the < (Adult) - ,
bottom of the white modified speech spectrum Female (28mm)
(canoe). . (Adult)
b. The LSM curve for Conversational Speech (65 dB) < | ]
should be within the white modified speech Child (20-25mm)
SpeCtrUm. . Perform Otoscopic Examination

N o=

c. The LSM curve for loud sounds (85 dB) (very loud - Align end of Probe Tube with the
left end of the appropriate guide

speech, clapping hands, etc.) is approximately 10 . Align tube marker with the red
dB below the UCL curve. marker above

4. Place Probe Tube in ear canal
. Confirm placement with Otoscope

. Perform Live Speech Mapping & REM

w

(=)
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Real Ear Measurements

In addition to Live Speech Mapping, the Avant REMsp supports all conventional Real Ear Measurements
(REM). All these tests are accessed from the main REM screen.

To begin, click the

REM

In general, REM tasks are performed as follows:

Fle Function Ear Audid Terget Stinuus Options.. Tools Hab

Audo || FieoRx | REUR | REUG | REIG | REAR  REAG

1)

REOR  REOG

B

O£ | RECD 4 ‘ T

658

LenEs  RehEw
©qSPL (dB)
120 L :
1 BEN PRN
101 L™ o
Wi Il
a Pl | 5ot =S
o | I @ OpR
04 I |-
®e @
601 |
| = g Msc
504 o 2
40+ & Setup NALNLY
< | | insest/Tip, BTE. Binawral.
w1 WORC5ch
J | )
125 % S0 70 ks & % & & &
Fiouercy (Ha] | ©
5 5
X -

Discard

Hep Back

4. Click Start. The test will stop itself after sufficient data has been
collected and averaged.

5. If you wish to delete a curve, simply select it with your mouse

and then click the Discard icon or press the Delete key.

6. When all measurements are complete, click the Back arrow to
return to the Avant REM main Screen.

E% e % button on the right of the Avant REM main screen.

Select the REM
test you wish to
perform from
the top row of
buttons.

Select the test
ear.

Select the test
stimulus.

Descriptions of the various “Stimulus” options are presented in the Help files under the topic “Signal

Types”. Access these by clicking on the “Help” tab at the top of the screen, and selection “Help Topics”.
Select an item from the list in the Index tab, and click “Display”.
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Stimulus Signal Types

Pure Tone
A pure sine wave. Crest Factor = 1.41 (3.0dB)

Broadband Noise (BBN)
Uniform random noise with normal (Gaussian) amplitude distribution. Can be weighted to White, Pink, Speech ANSI, and Speech
Byrne (see below.)

Pseudo Random Noise (PRN)
A "synthetic" broadband random noise. It is less uniform than BBN, has lower spectral density and random volleys. Can be weigted
to White, Pink, Speech ANSI, and Speech Byrne (see below.)

ICRA Noise
This stimulus was developed for measuring characteristics of non-linear instruments. The noise is weighted to Byrne LTASS.

ISTS

(International Speech Test Signal)

Initiated by European Hearing Instrument Manufacturing Association (EHIMA.) This signal is based on natural recordings of 21
female speakers in six different languages - American English, Arabic, Chinese, French, German and Spanish. The signal is largely
non-intelligible because of segmentation and remixing. The speech material was filtered to Byrne LTASS.

Crest Factor: 9.23 (19.3dB)

Rainbow Passage
Natural recordings of several voices reciting the rainbow passage. Shaped to Byrne LTASS.

Broadband Noise Weighting

White

This is essentially no weighting or filtering. The White Noise has flat power spectral density. Power at every frequency is equal.
Because the density of frequencies (individual cycles) raises with frequency, there is more energy in high octaves.
White-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless
specified by the manufacturer.

Crest Factor: BBN = 1.73 (4.8dB), PRN = 7.86 (17.9dB)

Pink

The noise is filtered so its energy per frequency (power spectral density) is inversely proportional to the frequency. Each octave
carries the same amount of energy. Comparing to White Noise, the Pink Noise energy drops approximately 3dB per octave.
Pink-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless
specified by the manufacturer.

Crest Factor: BBN = 3.67 (11.3dB), PRN = 6.55 (16.3dB)

Speech - Byrne

The noise is approximately weighted to International Long Terms Average Speech Spectrum (ILTASS) as described in Byrne et. al.,
1994.

The noise with this weighting is preferred for hearing aid fitting because its spectrum is the best approximation of the spectrum of
real human speech.

Crest Factor: BBN = 4.22 (12.5dB), PRN = 3.47 (10.8dB)

Speech - ANSI

The noise is approximately weighted to ANSI S3.42 Speech Noise.

The noise with this weighting can be used for fitting hearing aids. The slope of ANSI-weighted noise is not as steep as Byrne-
weighted, so there is more power in higher octaves. This will result in less gain required by the hearing aid to reach targets, but may
result in under-fitting at high frequencies.

Crest Factor: BBN = 4.46 (13.0dB), PRN = 5.17 (14.3dB)
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To activate specific REM tests, click the buttons as follows:

Audic

Opens the audiometry data entry screen. Use this if audiometry has not been previously
measured and entered into NOAH.

FittingRix:

Allows the selection of fitting rules to generate insertion gain targets. The following rules
are supported: ¥2 Gain, POGO |, POGO II, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-
NL1, NAL-NL2.

REUR

Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance
to a stimulus. Reported as dB SPL of output.

REUG

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a
stimulus. Reported as dB SPL of gain. If a real ear unaided response (REUR) curve has
been measured, the corresponding real ear unaided gain curve is automatically plotted to
the REUG screen.

REIG

The difference between the REUG and the REAG is called the Real Ear Insertion Gain
(REIG). This Insertion Gain information is used to compare to the target gain curve
selected for the client.

REAR

The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal
measured with the probe microphone close to the eardrum and the operating hearing
instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a
function of frequency, at a specified measurement point in the ear canal for a specified
sound field, with the hearing aid in place and turned on.

REAG

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG
allows you to see the gain at each frequency for each of the REAR curves measured.

REDR

REOR measures the effect on the natural external ear effects resulting from inserting an
ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR is
also referred to as Insertion Loss. REOR s also useful for validating the effectiveness of
venting or canal length changes to the mold.

REDG

The Real Ear Occluded Gain (REOQG) is the difference in decibels, as a function of
frequency, between SPL in the ear canal and SPL at the reference microphone at the
entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR
measurement curve, the corresponding REOG curve is calculated and automatically
plotted to the REOG screen. The REOG function is useful in determining the acoustic seal
of a hearing aid, relative to a sound field outside the ear.

0

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”.
These are signs of a build up of self generated low frequency energy in the ear canal. This
excessive occlusion can be measured objectively in the Occlusion Effect task.

RECD

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by
coupler measurements and is useful when fitting children or “difficult” to fit patients. See
the section on RECD later in this manual for more detail.
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Additional Tests & Features

Real Ear to Coupler Difference (RECD)

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by coupler
measurements and is useful when fitting children or “difficult” to fit patients. RECD measurements can be
conducted outside of a Hearing Instrument Test Box when using the optional MedRx RECD Coupler.

660-902 - RECD Coupler Assembly (REM use)

430032
430-030 2CC BTE 430033

2CC Body Adapter 2CCITE

Adapt
NS1141 AR Adapter
with O-Ring "

o
Plastic Tubing
NS1143

\ .
== -
601-159 (py
Coupler Mic ’

Probe Port b -
O &= :

601-170 660-111
Coupler With Plastic Ear Tips
Probe Port
with NS1140
O-Ring

660-110
Button
Receiver

B R P TTT L Lkl

430-015 Green Probe Tube Pack

The RECD values are used as a correction to coupler measures for that client’s hearing instruments. By
performing all subsequent measures in the coupler and applying the RECD corrections to the coupler
measures, the “real ear” factors are incorporated into the results. The resulting simulated measurements
provide information to select and make adjustments to the hearing instrument and verify adjustments in
the MedRx coupler rather than in the uncooperative client’s ear. This is particularly important in the case
of children, whose small volume ear canals enhance high frequency amplification more so than in
average adults. This is an essential consideration in determining the maximum output of the hearing
instrument.

If RECD data is present, the software will display an option to choose between Ear or Coupler
measurement on all Real Ear screens where measurements in a coupler are appropriate.

There are two ways to measure the REAR response with optional RECD coupler: using an insert
headphone or a hearing instrument.

If a hearing instrument is used, its volume control setting and other parameters should remain the same
for both REAR and coupler measurements. Set the volume control to moderate, and turn the
compression and noise reduction circuits off.

Using open-fit hearing aids for RECD measurements may result in invalid low and mid-frequency
measurements because of insufficient gain at those frequencies. Please contact your hearing aid
manufacturer for recommendations.
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How to perform the RECD task

First, perform the Ear Response task. This can be measured with a hearing instrument or an insert
earphone.

Ear Response with a hearing instrument

ANRNNP i 4 e Adjust volume of the hearing instrument to comfortable listening level.
S AN Turn the compression and noise reduction circuits off.

e Position the client less than one meter from the speaker and facing
the speaker.

e Place the hearing instrument and the probe microphone tube as for
all REM measurements.

e Select START to open the measurement type selection screen.

e Choose the Ear Response with a Hearing Aid option.
e Select OK to begin the test and wait until it concludes.

Ear Response with an insert headset

e Place the probe microphone tube as for all REM measurements but
use the insert headset instead of a hearing instrument. Connect the
insert headset into the speaker jack on the REMsp.

e Select START to open the measurement type selection screen.

e Choose the Ear Response with an Insert Headset option.

e Select OK to begin the test and wait until it concludes.
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Coupler Response
When the Ear Response is complete, you are prompted to perform a coupler response.

N

e Attach the hearing instrument or the insert headphone (must be the
same as in the Ear Response test) to the appropriate coupler and
place the probe tube inside the coupler.

e If a hearing instrument is used, be sure to perform this measurement
at the same volume control setting as the first measurement.

e Select START to open the measurement type selection screen.

e Choose the Coupler Response option or Use Stored to skip the
measurement (see note below.)

e Select OK and wait until the test completes.

e The calculated RECD curve is automatically displayed on the screen
and is stored in memory for correction of subsequent coupler
measurements made from the RECD function.

Note: If the REAR and the coupler response were measured with the insert headphone, the program
saves the coupler response curve for later use. In this case, to obtain another RECD, only Ear Response
with insert headphone measurement is necessary. This is possible because the coupler response does
not change provided that neither the coupler nor the insert earphone has changed.

Note: After measuring RECD, it is possible to perform Live Speech Mapping in the coupler as well. Look
for the “Measuring in” option on the LSM screen.
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Measuring Acoustic Feedback

Feedback (whistling, howling) is one of the most common complaints of hearing instrument users. Even
though many modern hearing instruments have sophisticated feedback management systems, knowing
exactly where the feedback is occurring can greatly reduce the time required to resolve the problem. The
AVANT REMsp system does an excellent job measuring and displaying acoustic feedback.
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Place the calibrated probe tube in the ear canal as
instructed previously.

Place the hearing instrument in the ear without
disturbing the probe tube.

Begin a Live Speech Mapping session as instructed
previously.

When feedback is present, click the Start button.

Acoustic feedback appears as a large spike in the LSM
response.

If a more specific frequency analysis of the feedback is
desired, change the resolution of the system to 1/24
octave by clicking the Options menu item and
changing the Analyzer selection using the pull-down
menu. This image shows the same feedback as above
at 1/24 octave.

Using this information, make any necessary

adjustments to the hearing instrument to reduce or
remove the feedback.
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Hearing Loss Simulator

The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the significant
third party. The program attenuates an input signal to simulate the audiogram. The third party
listens to the free field speakers. The third party can hear how their own voice is distorted by the
hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’'s Audiogram data. This data can be manually entered in
the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task

Fla Functon Ew Audo Mode Input Options... Tools Heb 1

o Select the Hearing Loss
0 ) e Simulator tab on the
toolbar.
- ~ 2. Enter the Audiogram
@ o | S values manually if the data
@5 e is not automatically
» i©m # 2 imported to this screen.
/=2 = 3 Select the input signal
: type: Mic, File or Record.
— (6) Select the track and the
i ; Play button on the control
8 | ® & panel. See below for
3 ,\/‘N j @ instructions on how to use
= L : the Record option.
I The HLS output is directed
Ao A ik e B . to the free field
S - loudspeakers.

4. Select Normal to play the input signal as a person with normal hearing would perceive it. Select
Simulated to turn on the simulation of the client's hearing loss. Toggle between these selections as
necessary.

5. The Reset option restores the audiogram to the original state. Use this option if you have modified
the audiogram while in the simulate mode but want to undo the changes. The changes to the
Audiogram that are made on the HLS screen are temporary and will not affect the client's original
audiometry record.

6. A volume control adjustment bar allows modifying the audio for manual adjustment of the output level
of the free field speakers. This allows the practitioner to demonstrate improvements to hearing loss
with amplification or what happens when further hearing loss occurs.

7. To stop the playback, select the Stop button on the player.

Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing loss.
Record Input Option
This option allows recording and play back of the voice of the third party.

Note: The LSM option appears on the bottom half of the display. This is so the unaided and aided results
can be displayed simultaneously for the patient and significant third party.
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Master Hearing Aid

Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits of
amplification to an inexperienced user. The system applies the fitting rules by default to the patient's
audiogram and simulates a hearing aid. The patient listens to this signal through the headphones.
Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency in Hz
on the horizontal axis. The plot on the graph represents the gain applied to the patient’s Audiogram. The
NAL-RP is applied by default. A new rule can be selected from the list on the right side of the display. A
volume adjustment bar allows for manual adjustment of the output level. The control panel on the right of
the display provides options for input signal source and the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for the left
and right ear, the selected fitting rules will be applied to each ear separately. Different rules may be
entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an audiogram is entered
only for one ear, the gain will not be adjusted for the opposite ear and the sound for that ear will be
normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If Monaural
mode is selected, the sound will be heard only from the channel corresponding to the active ear when the
channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the right probe mic for live speech input to the
headphones. The clinician or significant third party can speak into the microphone for this activity. Note:
there is a processing delay between the input and playback. Make sure that the client cannot hear the
voice directly but only through the headset. If this is not possible, use the Recorder (describer below) to
simulate speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes with a
preset MedRx Sounds Sensations set of files. After the option is activated, use the player panel to control
the playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to control the
playback.

Record input mode allows the clinician or third party to record a sample of their speech which can then
be replayed for repeat comparisons under different amplification conditions for the patient. Refer to the
interactive Help system by pressing F1 or clicking the Help icon to learn more about the recorder.
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How to use the Master Hearing Aid:

Select the Master Hearing Aid

@) ® =—— — (MHA) icon from the main screen.
. - &3 .+ 2. Enter the Audiogram values
- A S manually if the data is not
. /——-’*— b /@~ = 2 automatically imported to this
."5 % S0 Mok IRE K & & & ~’S & S0 Mok IMA K & & & ®£ N’-:;'u screen.
e e I

win @ 3. Select the input signal type: File,

=] @ O CD, Mic, or Record.

B ;\f/v. e 4. Select Monaural or Binaural.

s -

o

Select the Normal icon, which will send the input signal through to the inserts without modification.
The patient is listening to the signal without any amplification benefit. Select the Simulate icon to
modify the input signal according to the selected rule. This selection allows the patient to hear the
benefits of amplification. Toggle between these two selections as necessary.

6. If the simulated frequency response needs to be adjusted, based on feedback from the patient,
manually edit the response by clicking on the gain curve at the desired frequency and new gain
level. The gain curve of the selected test ear on the control panel can be edited. To edit the other
ear, click the appropriate test ear icon on the control panel first.

i G| | T P S Hint: Use the track return icon on the player control panel to replay one
EQ) W o« » track continuously.

The Reset option restores the rule to the original state. Use this option if
you have modified the rule but want to undo the changes.

Printing

Printing within the Avant REM software is very simple.

P Function Ear Audio Stimulus From the File menu, click one of the following options:
E‘f: Print Setup — selects the printer you want the report to be
” — sent to. Avant REM prints to any installed Windows
pen kel :
o printer.
Clear Session Data Page Setup — Allows you to set margin sizes and the
Expor [T default text header for your reports.
zz;t:::;zm I Print Preview — Shows you what your report will look like
Prink Preview . before you print it.
Ig Print — Sends the report to the printer.
Go Back CrlBack —
Exit Alt-F4
I an I 2
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Rainbow Passage

When the sunlight strikes raindrops in the air,
they act like a prism and form a rainbow. The
rainbow is a division of white light into many
beautiful colors. These take the shape of a long
round arch, with its path high above and its two
ends apparently beyond the horizon. There is,
according to legend, a boiling pot of gold at one
end. People look, but no one ever finds it. When
a man looks for something beyond his reach, his
friends say he is looking for the pot of gold at the

end of the rainbow.
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Symbols that may be used:

1

Read the instruction
manuals for safe usage
of the device.
(operating instructions)

EC| REP

Authorized
Representative in
Europe

Caution, General warning
sign

Start (of action)

Loudspeaker (Speaker)

l

SN

Indicates that the device
serial number will follow

()

Non-ionizing
electromagnetic radiation

35C

10C

Temperature limitation

Stop (of action)

o

N

Headphones

Type B applied part.
(Type B equipment)

I
Special Disposal
Required

Read the instruction
manuals for safe usage
of the device
(operating instructions)

)

Percentile Setup

Microphone

0]

Manufacturer
(MedRx)

90%

30%

Humidity
Limitation

Class Il equipment

\ 4

Calibration

Recording

The date of manufacture is shown on the original calibration certificate. The year
of manufacture is shown in the fourth character in the serial number. M=2014, N=2015, P=2016,

Q=2017 etc.
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Limited Warranty

MedRx, Inc. warrants this product to be free from defects in material and workmanship for one year
from the time of purchase. If this system fails to perform

as specified during this period, the purchaser is responsible for calling MedRx at (888) 392-1234 or
(727) 584-9600. The company's representative will advise the owner to either return specific
components or the entire system to:

MedRX, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or components and ship
the system promptly back to the owner. There is no cost for the repair or return shipping, provided
the system is one year old or less and has not been misused, abused or damaged. Such damage
includes, but is not limited to, dropping, exposure to excessive heat greater than 100°F and
water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and exclusive
remedy of the purchaser. MedRx shall not be liable for any consequential or incidental damages or
for breach of any express or implied warranty. Except to the extent of applicable law, any implied
warranty, merchantability or fithess of this product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the purchaser's request,
charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is in§;called on this product which is not
pre-approved by MedRx, Inc. Approved software includes NOAH = and HIMSA approved hearing aid
manufacturer programming modules for fitting hearing aids.

MedRyx, Inc. is not responsible for problems resulting from installation of unapproved software or
hardware. In the event of unapproved software or hardware installed on the system causing a
conflict, MedRx will service the product for a fee to be determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject to the following (where
applicable).

1. A $300 deductible per repair.
2. Extended warranty does not include cables, connectors or peripherals.
3. Extended warranty of the Video Otoscope covers optics only.
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